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Introduction 
The Cost Estimating Module is an automated search, retrieval, and tabulation process to be used in the 
development of estimated costs. 

Although the program may be run in stand-alone mode, it is most powerful when connected to the 
Manfact database. While connected, various files are utilized to support the estimating process 
including; bills of material, routings, vendor quotes, purchasing history, and work order history. Once 
the desired data has been extracted, the user may continue to refine the estimate in "offline" mode. 

 The estimate is developed using a hierarchical structure that allows costs to be rolled-up and 
reported at various levels. 

 The application uses a flexible spreadsheet format that allows the user to easily add and delete 
items from the estimate, and change the structure of the estimate. 

 Estimated hours and amounts are stored by user-defined cost categories called Resources. 
Various estimating parameters are defined for each resource including: labor rate, mark-up 
percent, escalation rate, complexity factor, etc. (See Resources Display for more information.) 

 The estimate may be developed for a specified quote quantity, taking into account smaller per-
unit setup costs and more favorable prices due to larger purchasing quantities. 

 A bill of material may be automatically loaded from the Manfact database and copied into the 
estimate. Each component of the BOM then becomes a line item on the estimate, which may be 
modified by the user as desired. (See Load Bill of Material for more information.) 

 The system stores multiple cost sources for each estimate line item. Cost sources may be entered 
by the user, or obtained automatically from the Manfact database. For purchased parts, cost 
sources include purchase order history, vendor quotes, and current quantity on-hand. For 
assemblies, labor costs may be based on either a standard routing or work order history. (See 
Cost Sources Display for more information.) 

 The system calculates a suggested selling price based on the desired profit percentage specified 
by the user. Profit requirements may vary by resource code if desired. 

 To provide additional reporting flexibility, the estimate may be exported to Microsoft Excel or 
Microsoft Word. (See Exporting to Excel or Exporting to Word for more information.) 

 

Each estimate is maintained as an individual Access database. These files may be stored on the user’s 
local hard-drive or on a network drive. Thus, estimates may be easily copied or shared among different 
users using standard Windows desktop tools. 
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Cost Estimating 
The main screen is comprised of six "tabs". 

Estimate:  The Estimate Display is presented in spreadsheet format. Each row in the spreadsheet 
represents an item that will contribute to the total cost of the project. 

Item Detail:  The Item Detail Display contains more in depth information, including detailed 
information on labor and operating costs, for each item or row from the Estimate Display. 

Cost Sources:  The Cost Sources Display contains detailed cost source information for each item or row 
from the Estimate Display, and allows the user to choose from multiple cost sources. 

Summary:  The Summary Display contains categorized project costs, calculated price and estimated 
profit for the project. 

Resources:  The Resources Display contains detailed resource information for each item or row from 
the Estimate Display. 

General:  The General Display contains estimate and customer information and user notes. 

 

Open / Create an Estimate Database 
To create a new Estimate, select Open/Create an Estimate from the File Menu.   
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Browse to the folder where you wish to store your estimates.  Open an existing file, or type the name of 
a new Estimate File you wish to create and click the [Open] button.  If the estimate file does not exist, 
the following message is displayed: 

 

Click [Yes] to create a new Estimate File. 

Creating a New Estimate 
Each row in the Estimate Display represents an item that will contribute to the total cost of the project. 
The item may be an assembly, a component part, a manual estimate, a separate project, or summary.  
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Any row in the Estimate Display that contains an error will be highlighted in RED.  
 

 

Most Errors that occur in the Cost Estimating Module stem from a lack of data. Note that in the above 
screen shot, no Cost Source data has been entered in the highlighted rows. If said data is not available 
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from Manfact, you will need to research and enter the correct information.  In this example the missing 
data is a routing for a phantom assembly.  This would be an example of when you can clear an error. 

By selecting "Errors" from the Edit menu, there are four options for handling Line Item (row) Errors. 

 View Errors will display a line-by-line list of errors.  

 Selectively Clear Current Line Errors allows the user to select which line errors to clear. 

 Clear All Current Line Errors clears all errors on the current line. 

 Clear All Errors on All Lines clears all errors on all lines. 

* Remember, if you clear line errors, and do not enter data in the cells in question, you will not be 
calculating that information in your Estimate. 

The following columns are displayed: 

Column Name Description 

[+] or [-]  The estimate is a hierarchical structure displayed in outline form. Click [+] to 
expand an item and see constituent parts, or [-] to collapse and hide constituent 
parts. 

Level The roll up level of the item. 

Description The name or a brief description of the item. 

Type Select from the drop-down menu. Each item (row) will be one of the following 
types: 

• Assembly:  Bill of material and routing data may be loaded from the Manfact 
database. Labor costs may be estimated using routings and/or historical work 
order data. 

• Part:  Vendor quotes and purchasing history may be used to estimate the cost. 

• Manual: the user must enter all values. 

• Summary:  A subtotal line. 

Flat Fee Check for Flat Fee Items. 

One Time Check for One-Time Items. 
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Column Name Description 

Part Number The Part Number is displayed for Assemblies and parts. Where applicable, the user 
may enter the part number, or it may be updated by the system when a bill of 
material structure is loaded onto the estimate. 

Qty The quantity of this item required to produce one unit. 

Ext Qty The unit quantity of this item multiplied by the quote quantity. (See General 
Display.) 

Notes Any applicable notes for each row. 

Source The source used to estimate cost for this row. (Routing, Work Order History, 
Vendor Quote, Purchase Order History, or Manual Estimate.) 

Source Doc The identifier of the document used to estimate this row. (Work Order Number, 
Purchase Order Number, Quote Number, or Routing Identifier.) 

Source Date The date of the Source Document. 

Source Qty Source Quantity as of the Source Date. 

Inc Cost The incremental cost of the row, excluding any costs rolled-up from lower levels of 
the estimate. 

Sub Cost The portion of the total cost rolled up from lower levels of the estimate (system 
calculated). 

Total Cost Total estimated cost for the row (item). 

Inc Hours Incremental Hours of the row, excluding any hours rolled-up from lower levels of 
the estimate. 

Sub Hours The portion of the total hours rolled up from lower levels of the estimate (system 
calculated). 

Total Hours Total estimated hours for the item. 

Material % The total material cost of this row, divided by the total material cost of the 
estimate. 

Labor % The total labor cost of this row, divided by the total labor cost of the estimate. 

Overhead % The total overhead cost of this row, divided by the total overhead cost of the 
estimate. 
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Column Name Description 

Other % Any other cost of this row, divided by the total miscellaneous cost of the estimate. 

Material $ Dollar amount for Material Cost of this row. 

 Dollar amount for Labor Cost of this row. 

Overhead $ Dollar amount for Overhead Cost of this row. 

Other $  

Item Detail 
This screen displays specific details, including labor and operating costs, for selected items or rows from 
your Estimate.  The upper section displays Descriptive, Source, Quantity, and Cost data for the item. 

Use the "Scroll Box" to navigate to other line items. 
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The following columns are displayed: 

Column Name Description 

Resource Resource Code or abbreviation. 

Description Resource Description. 

Rate Resource Rate used for calculation. 

Base Unit Setup Hours Per-unit setup hours for each resource. 

Base Unit Run Hours Per-unit run hours for each resource. 

Base Unit Setup Cost Per-unit setup cost for each resource. 

Base Unit Cost Total per-unit Cost for each resource, excluding any values rolled-up from 
lower levels of the estimate. 

Adj. Unit Setup Hours Unit Setup Hours may be adjusted for unforeseen difficulties or to adjust final 
cost. 

Adj. Unit Run Hours Unit Run Hours may be adjusted for unforeseen difficulties or to adjust final 
cost. 

Adj. Unit Setup Cost  

Adj. Unit Cost  

 

Cost Sources 
This screen displays detailed cost source information and options for items selected from your estimate. 

The information shown on the Estimate Display represents the cost source currently selected for the row. 
You may scroll through a list of available sources and optionally select a different cost source for the 
item. 

 Use the "Scroll Box" or the "Scroll Arrow" (next to the Part #) to navigate to other line items. 

 Click the "Load Sources" Button to Load Cost Sources from Manfact. (The line directly below 
displays the last date and time Cost Sources were loaded.) 

 Click "Best Fit" to allow the Cost Estimating Module to automatically select cost sources, based 
on order quantity and date. 

 Click the checkbox to Freeze Source Selection. 
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 Click the [Recalculate] Button to recalculate Summarized Qty. and Order Qty. (You may edit 
Minimum Qty. and Order Multiple from this screen.) 

 

The following columns are displayed: 

Column Name Description 

Use This Click to select which cost source data to use in your Estimate. 

Don’t Use Click to ignore this data in your Estimate. 

Source Type Displays the source type for the line item. 

Source Doc Cost Source Documentation. (Work Order, Purchase Order, or Routing Number). 

Source Line Item Line number on Cost Source Type (if applicable). 

Source Date The Date of the Cost Source documentation used. 

Source Qty Source Quantity as of the Source Date. 

Unit Cost Per-unit Cost of the item. 

Setup Hours Hours required for Setup. 
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Column Name Description 

Unit Hours  

 

Summary 
After calculating your Estimate, this screen will display summarized Cost Information with user defined 
sub totals for related Resources. 

It also displays Total Estimated Cost, Calculated Price, and Estimated Profit for the project. 

 

Resources 
The cost of an item may be broken down into multiple user-defined cost buckets called resources. In the 
Manfact system, resources may be assigned to Work Centers to categorize labor. In addition to labor, 
your company defines other types of resources including material, outside processing, fixed overhead, 
variable overhead, miscellaneous overhead, cost of money, and profit. 

Scroll down to see definitions of all columns displayed. (Additional columns become visible as the 
screen is scrolled to the right.) 
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The following columns are displayed: 

Resource Code - Resources are coded by type or process. 

Type - Select Line Item Type from the pull down menu. Each 
Item will be one of the following types: 

Material: Any Material Resource used. 

Labor: Any Process that requires labor. 

Fixed Ovhd.: (Fixed Overhead) Resources with fixed 
overhead or cost. 

Var. Ovhd.: (Variable Overhead) Resources with 
variable overhead or cost. 

Other Ovhd.: (Other Overhead) Any miscellaneous 
overhead or cost. 

Outside Proc.: (Outside Process) Any cost incurred via 
outside services or processes. 

Other Cost: Any resource that does not fit the above 
categories. 

Subtotal: The Summary Display will show a subtotal 
for any sets of resources between Subtotal rows in this 
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Display. 

Description - A description of Resource Code or Resource Type. 

Rate - Rate used for calculating Labor or Overhead. 

Hours or Amt. - For overhead resources, specify whether the calculation 
is based on labor hours or resource amounts. 

Complexity Factor - This factor may be used to inflate (or deflate) the 
estimated labor hours for a specific resource during the 
cost roll-up process. The hours are simply multiplied 
by the entry you make in this field. 

Escalation Rate - This is an inflation rate per year that may be applied to 
material costs. The following formula applies: 
Estimate = Q * ((R + 1) ^T) 
Q = Price Quoted 
R = Escalation Rate (expressed as a decimal) 
T = Time in years 
For example, we have a quote for $100 that is one year 
old, and we expect to begin production one year from 
now. So the quote will be two years old by the time we 
are ready to purchase the material. Assume an 
escalation rate of 3% per year. Our estimated cost is: 
100 * (1.03)²  =  $106. 

Profit % - Profit percentage for item or process. 

Cost of Money % - Enter Cost of Money % or interest rate for resources 
that tie up capital over time. 

Base Resources -  

General 
This screen displays general information on your estimate, including customer, model, estimate history, 
project and profit information. 

 Adjust Quote Quantity to calculate for the number of units. 
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Common Cost Estimating Procedure 
 Set Up Resources 

o Below is a sample copy of what a Resource view might look like. 

 

 Set Cost Estimating Options (see Options) 

 Enter Estimate Details (see Estimate) 

o If you have entered an assembly Load Data from Manfact – Bill of Materials (see Load 
Data from Manfact).  The following is how the view will look after the Bill of Material 
has been loaded. 

o If you have entered a part or exploded an assembly Load Data from Manfact – Cost 
Sources (See Load Data from Manfact) 

o If you have entered a project Load Data from Manfact – Project (see Load Data from 
Project). 

o Review the Cost Source information and verify the selection of the source is correct. 

 For Projects select the Project line item on the Estimate page 
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• Double click the Project line item.  This will take you to a blank Item 
Detail view. 

• Click on the Cost Source tab. 

• Click on the [Load Sources] button 

• Select the Project you want to use for the Estimate.  

o Calculate the Estimate (see Calculate Estimate) 

o Review the Estimate Results.  As required review the Item Detail or Cost Source view. 

Note, you may show red/pink lines that indicate an error when there really isn’t one.  This will occur for 
assemblies coded as XP (Phantom) or Top Level Projects. 

 

 Once everything appears accurate, check your Summary view to see the total costs and profits of 
this Estimate.  Below is an example of the Summary view after all actions has been completed. 
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 If the totals do not seem reasonable go back and review the details of your estimate. 

 The last thing you can do is review the General Display.   
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Main Menu Options 
Following is a brief description of the options available from the Main Menu of the Cost Estimating 
application. 
Menu Option Description 

File Open/Create 
an Estimate 

Your cost estimating information is stored in a Microsoft Access Database. 
Use the Open Dialog screen as illustrated below to locate your file. Note, the 
file name will default to the last database you opened. 

Creating a New Database 

You can create a new database using this screen. Simply type in a new name 
at the file name prompt, and the system responds: 

 Unable to Locate File. Do You Wish to Create It? 
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Click [Yes] to create the new database, or [No] to cancel. 

File Find an 
Estimate 

Locate an existing estimate.  (See Find an Estimate). 

File Save 
Estimate 

Save Estimate to the File.   

File Save 
Estimate As 

First save of an Estimate requires you to define the Save As file name and 
location.   

File Revert to 
Last Save 

This option will restore your Estimate to its condition as of the last time you 
saved it to disk. 

File Export Export data from the active spreadsheet.   

File Print 
Current 
Display 

See Print in General Section. 

File Export to 
Excel 

See Export to Excel in General Section. 

File Export to 
Word 

See Export to Word in General Section. 

File Import a 
Worksheet 

See Import a Worksheet in General Section. 

File Exit Close the application 

Edit Copy Copy data to the Windows clipboard.   

Edit Cut Cut data from the field and copy it to the Windows clipboard.   

Edit Paste Paste data from the Windows clipboard.   

Edit Fill Update all of the selected cells from the Windows clipboard.   

Edit Insert a 
Row 

Insert a Row immediately above the row you have your cursor on. 

Edit Delete a 
Row 

Delete the Row you have your cursor on. 

Edit Indent Row Indent the Row you have your cursor on. 

Edit  Outdent 
Row 

Outdent the Row you have your cursor on. 

Edit Errors See Errors in Estimate Section. 

View Expand All Expand and show all levels of the estimate. 

View Collapse All Collapse and show only the top level of the estimate. 

View Unhide All Expose all columns previously hidden. 
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Columns  

View Auto Fit 
Columns 

Automatically adjust the width of each column to accommodate your data.  

View Zoom View, print and/or edit the expanded contents of a field.   

View Display 
Options 

Set user preferences affecting the appearance of the screen. 

Tools Calculate 
Estimate 

See Calculate Estimate 

Tools Load Data 
from 
Manfact 

See Load Data from Manfact 

Tools Initialize 
Resource 
Table 

See Initialize Resource Table 

Tools Search for 
Part in 
Manfact 

See Search for a Part in Manfact. 

Tools Search for a 
Project in 
Manfact 

See Search for a Part in Manfact. 

Tools Find an 
Item in the 
Estimate 

See Find an Item in the Estimate. 

Tools Find Next See Find Next. 

Tools View 
Estimate As 
Average 
Unit Cost 

See View Estimate as Average Unit Cost. 

Tools Options See Options. 
 

Right Click Menu 
The following tasks can be found on various menu options. 

Copy - Copy data to the Windows clipboard.   

Cut - Cut data from the field and copy it to the Windows clipboard.   

Paste - Paste data from the Windows clipboard.   
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Fill - Update all of the selected cells from the Windows clipboard.   

Cancel - Cancel last action. 

Undo - Undo last action and return information as it was before the action. 

Select All - Select all transactions on the view. 

Sort by 
Ascending Order 

- Sort transactions in ascending order. 

Sort by 
Descending Order 

- Sort transactions in descending order 

Find an Item in an 
Estimate 

- See Find an Item in the Estimate. 

View Item Detail - Takes you to Item Detail View (See Item Detail) 

View Cost 
Sources 

- Takes you to Cost Sources View (See Cost Sources) 

Clear All Errors 
on All Lines 

- Clears all errors on all lines. (See Errors in Estimate section.) 

Zoom - View, print and/or edit the expanded contents of a field.   

File Menu 

Find an Estimate 
This feature allows you to search for a specific Estimate. 

 When you select Find an Estimate from the File Menu the screen below appears. 
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 If you know the File Name and Path of the Estimate you wish to locate you may enter it 
manually, or Click the Browse Button. 

 Use the Browse Dialog (illustrated below) to locate the folder in which your file is located.  

 If you skip this step, the system will search the entire Hard Drive. (This may take several 
minutes, depending on the size of the selected Drive.) 
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 Highlight the row with the File Name you wish to work with.  Then click [Open Database] 

 Or you may click the Search Criteria Tab (illustrated below) to define the parameters by which 
you wish to locate the Estimate. 

 If you skip this step, the system will return the entire contents of the selected folder. (matching 
the selected file extension) 
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 Select the Item you wish to use for your search. (Use the Scroll Bar to view the full list.) The 
following Items are available: Estimate Number, Revision, Customer Name, Description, Model 
Number, Quote Quantity, Starting Unit, Award %, Status, RFQ Date, Project Start, Submitted, 
Won/Lost, Cost Calculated, Price Calculated, Price Quoted, Gross Profit.  

 Fill in the fields to the right of the selected Item. 

Contains: Select "Contains", "Starts With", or "Ends With" from the pull down menu.  

Text: Enter the text, or partial text, for which you wish to search. (In the example above, we are 
searching for a Customer Name that Contains "”ABC” 

(Note: The Contains and Text columns are disabled for any Item that is a date, set quantity, or 
dollar amount.) 

From and To: Use these columns to enter a range of values or dates for any Item that is a date, 
set quantity, or dollar amount. 

 Click the Find Now Button when you have entered your search criteria. 

 Your search results are displayed on the screen below. 
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 Click on any cell to select the database on that row. 

 Use the [Open Database] Button to Open the selected file. 

Tools Menu 

Calculate Estimate 
Select this option when you are ready to calculate the estimate. Be sure you have entered or imported 
data into all required fields. (You may also use this feature to "find" any lines with missing data.) 

The Cost Estimating Module calculates the estimate in the following manner: 

 Cost Sources for each Item are finalized and multiplied by Qunatity, Extended Quantity, 
Quantity Ordered, and any Adjusted Costs. 

 Cost Source data is applied to Resources, such as Overhead, and calculated with consideration of 
Rate, Complexity Factor, Escalation Rate, Profit %, and Cost of Money %. 
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 Incremental and Sub Costs are Rolled Up to each level. 

 The dollar amounts for each row (Item) are calculated to percentages of over all cost for 
Material, Labor, Overhead, and Other cost. 

 The Summary is generated, with consideration of all Cost Source data, Resource data, and user 
defined subtotals. 

 Any lines containing Errors or incomplete data are highlighted. 
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Load Data From Manfact 
This process allows you to begin building or add to your estimate using the information available from 
Manfact.  

The following options are available: 

Load Bill of Material  
This option is available for any Assembly Item. 

Use the screen illustrated below to locate the desired Bill of Material. 

 

 Select file type from which to load this data Production, Engineering (enter ECO Number), or 
Work Order (enter WO Number). 

 Enter Assembly Number or Search by clicking the Icon to the right. (See Part Number Search) 

 (If desired) Click to Explode Bill of Material Beyond First Level. 

 Set Effective Date. 

 Click [OK]. 
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Load Cost SourcesYou may manually enter Cost Source information or select from various Cost 
Sources stored in Manfact.  

 When you select "Load Data From Manfact" > "Cost Sources" from the Tools Menu, the Cost 
Estimating Module searches Manfact for all Cost Source Data available for each Item in the 
estimate. All cost sources found for any given Item will be shown in the Cost Source Display. 
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Load ProjectThis option is available for any Project. 

Use the screen illustrated below to locate the desired Project. 

 

 Enter the top level Project Number or you may perform a search by using the search icon to the 
right of the entry field. 

o If you perform a search below is the first screen that will appear. 
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o Once you have updated all of your selection criteria click on the [OK] button and you 
will be taken to the following screen. 

 

o Afterwards you will get the specified records on the Search Results Tab. 

Initialize Resource Table 
The following two methods are available to aid in Resource Initialization: 

Load From Manfact 
Information for several commonly used resources is available from existing Manfact Work Order 
Records.  

 The system can load this data into your current estimate. 

For example: If your company’s engineering labor has previously been calculated at the rate, 
complexity factor, profit %, and cost of money %, you wish to use in the current estimate, you 
may load these rates from an existing Manfact Work Order Record. (You may still edit any of 
this data after initializing the resource table.) 
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Copy From Estimate 
Information for commonly used resources may be available from an existing estimate.  

 The system can copy this data into your current estimate. 

For example: If your company’s engineering labor has previously been calculated at the rate, 
complexity factor, profit %, and cost of money %, you wish to use in the current estimate, you 
may copy these rates from an existing estimate. (You may still edit any of this data after 
initializing the resource table.) 

 Use the screen illustrated below to browse for the estimate from which you wish to copy 
resource information. 
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Search for Part in Manfact 
The Part Number Search query helps you locate a Manfact Part Number using a variety of search criteria 
and provides you with an Inquiry Only process for users who do not have Parts Master Update 
authorization.  
Environment
The main screen is composed of eight “tabs”. The Search and Results tab are the two tabs that will be 
utilized in locating a part number.  

 
The remaining tabs display information that is contained in the Manfact PARTS and Inventory files, 
organized by departments: Engineering, Planning, Material, Purchasing, Marketing and On Hand.  
Locating a Part Number  
When you enter the Part Number Search procedure, the first tab that you will be taken to is the Search 
tab.  If you know the part number that you want to inquire on, you can simply enter the part number, 
press the Enter key and you will be immediately directed to the Engineering tab.  If you don’t know the 
specific part number, but know some basic information about the item, several fields are available to use 
in narrowing your search.  
The fields you may use in your search include: Part Number, Description, Vendor Description, 
Mfg#*Part#, Notes, Vendor #, Product Class, Sub-Class, Part Type, Category, Buyer, Planner, and 
Make/Buy Code.  You may use as many of the search fields as necessary to narrow your search to the 
fewest number of records.  If you don’t know the specific details of a particular field, you might use 
wildcarding to enter only a portion of the item’s part number, description, etc.   
To further assist you in locating the desired part number, you may Sort the search results by either the 
Manfact Part Number or the Engineering Description.  
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Search Results
After you choose the [Search] command, the results are displayed on Tab 2 “Results”, Part Number 
Search. One part number and its associated description are displayed on each row of the list. You can 
Returning to the Search window and using the Sort By option sort change the way the information.  

 
For more details on the Part Number Search application see the full documentation. 

Note:  The NCC Part Number Search Query is sold separately.  If this option is not currently available, 
please contact your System Administrator or NorthClark Computing, Inc. to obtain a copy of 
NCC_PARTSQ. 
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Search for Project in Manfact 
If you perform a search below is the first screen that will appear. 

 

 Once you have updated all of your selection criteria click on the [OK] button and you will be 
taken to the following screen. 
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 Afterwards you will get the specified records on the Search Results Tab. 

Find an Item in the Estimate/Find Next 
You may search your Estimate for a specific item, or specific information. You may search for this data 
again by selecting Find Next. 
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 Select the field you wish to search from the pull down menu. 

 Enter the text for which you wish to search. 

 Select to match Case or Whole Field Only. (You may leave both unselected to just jump to the 
next place the text occurs.) 

View Estimate as Average Unit Cost 
The view of an Estimate provides the user with a display that is identical but has been divided by the 
Estimate quantity.  Below is an example of the Average Unit Cost view. 
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Compared o the original Estimate page. 
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Options 
You may customize your estimate as per the options displayed below: 
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 Apply Overhead from work center: Overhead will be calculated automatically and included in 
the estimate. The calculation may be based on work center rates and/or overhead pools assigned 
to the estimate. 

 Re-analyze Cost Sources for Best Fit: The system can select a Cost Source for each item based 
on the "best fit", taking into account the order quantity and the date of the Cost Source. 

 Roll Up Labor Rates: Use Work Center Rates or Resource Rates: In the Manfact system, 
resources may be assigned to Work Centers to categorize labor, or you may modify Resource 
Rates from the Resources Display. 

 Oldest Valid Vendor Quote, Purchase Order, and Work Order: Use the arrows to select age 
limits for Cost Source documentation. 

 Maximum Number of Cost Sources: Use the arrows to limit total number of Cost Sources used. 

 Purchase Parts Best Fit Per: Quantity on Hand or P.O., Vendor Quote: When selecting the "best 
fit" cost source for a part, the system can include Quantity on hand for any item, and increase to 
the Minimum Order Qty, rounded to the nearest Order Multiple for the part. You may alternately 
select to use Only a P.O. / Vendor Quote for your estimate. 

 Reset Min/Mult. Quantity: Minimum Quantity and Order Multiple may be adjusted from the 
Cost Sources Display. Check this box to reset. 

 Decimal Places: Select decimal places for summarized amounts. 
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General Information 

Printing a Spreadsheet 
Below is a sample of the screen that will appear when you select the Print option.  This will print the 
current active spreadsheet, so be sure to click on the spreadsheet you wish to print before choosing the 
Print option. 

 
Range - Selecting a Print Range 

You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted 
on the current screen), the current page (only the rows that are currently visible on your screen), or a 
range of page numbers.  

Orientation - Portrait or Landscape  
You may print your report in portrait mode (normal) or landscape mode (sideways). Printing in 
landscape mode will allow you to fit more columns of information on your report.  

Margins - Report Margins  
You can make your report more attractive by setting the top, bottom, left, and right margins. Reduce 
the left and right margins if you need to fit more columns on the report.  

Units - Inches or Centimeters?  
Are the margins you entered expressed in inches or centimeters?  

Page Order  
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If your report is too wide, it may span multiple pages. When this occurs, do you want the report 
printed from top to bottom or left to right?  

What Do You Want to Print?  
You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  
Your report may have up to three lines for the heading, and one line for the footer. The system 
initially displays a default heading, which you may modify if desired.  
Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  
The columns that are available for printing are listed. Select the columns you wish to include on your 
report.  

Importing Data from Excel 

This screen below is displayed when you choose the option to Import data from a Microsoft Excel 
spreadsheet, a tab-delimited text file, or a comma-separated text file. The data will be imported to the 
current active spreadsheet, so be sure to click on the desired spreadsheet before choosing this option. 

 
Import File Name 

Enter the path for the file that you wish to import.  You may browse the files by clicking on the 
button next to the text box. 
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Header Rows 
Enter the number of rows at the beginning of the file that are not to be imported 

Import File Type 
Select the type of file that you are importing 

Data Mapping 
Enter the Column Number or Letter where data resides on the Excel file. You may revert to the 
original selections by clicking on the [Reset] button.  

Import Data 
Click OK to begin the import procedure. 

Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 

 
Save As File Name 

Enter the pathname of the file you wish to create.  You may Browse the files by clicking the button to 
locate the drive and folder where the file will be stored. 

Sheet Name 
Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Export to Excel or to a File? 
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You may export the contents of the display directly to Excel, or you may choose to create a file in 
Excel format. 

Create a Log File? 
Select this option to create a log file. The log file contains error messages and other information 
about how your Excel file was created. The name of the log file is "CreateExcelFile.log", and it will 
be stored in the same folder as your spreadsheet. 

Data Mapping 
You may move data to alternate columns by changing the column number or letter.  You may also 
remove a column by removing the row that contains the column information you do not wish to 
export.  You may reset back to the original column by clicking the [Reset] button. 

Export Button 
After all required information has been entered click the [Export] button to export your data to 
Microsoft Excel. 

Exporting to Word 
This screen is displayed when you choose the option to export data to Microsoft Word.  

 

*You must specify a template, filename, and pathname prior to creating your Word Document. 

Use a Word Template 

You may browse for a Microsoft Word Template to use for your Estimate. 

Create Word Document 

After all required information has been entered, click this button to export you data to Microsoft Word. 

View Word Field Codes 

Click here to view or edit Word Field Codes to be used in your Estimate Document. 
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Editing Features 
Copy, Cut, Paste and Fill 
You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  
To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. 
There are multiple ways to enter this command:  
1.  From the Edit menu choose Copy. 
2.  Click the Right Mouse button, and then choose Copy from the pop-up menu.  
3.  Click the corresponding icon on the toolbar.  
4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 
You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  
To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy. Now click on the row header that you want to copy the data 
to and choose Paste. 
If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells. This command will update each cell with the current information from the clipboard. 
 Zoom 
This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

• You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu, clicking the 
magnifying glass on the toolbar, or selecting Zoom from the right click menu.   

• The Column Name will appear in the Title Bar with "Edit" or "View".  You may edit the field 
when it is allowed.   Click "OK" when finished, or "Cancel" to revert to the original data.  

• To print the selected item, click on the printer icon and the information will be sent to your local 
printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, "View" 
will appear in the Title Bar, and there will only be a single command button labeled "Done". 

Customizing Your Display / Arranging Columns 
Use the Customize Display Screen to make the following changes:  

 Each tab contains a list of fields that corresponds to a screen used in this application.  Use the 
checkboxes to show or hide each field.  

 Select the color to use for highlighting Summary Rows. 

 Select the color to use for highlighting Rows that have errors. 

 You may opt for the system to “Remember Screen Size and Column Widths”. Any changes you 
make to the screen's appearance will be saved and applied the next time you launch this 
application.  
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 Indent Description by Level.  Checking this box will allow you to view the estimate as indented 
structure.  This may make it easier for you to follow the flow of the estimate. 

 Click "OK" to apply any changes you have made or "Cancel" to revert to the previous settings. 

 

Note, these settings are stored in the Windows Registry for each user. 

Wildcarding 
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 

Part Number:  XTR… (or 
XTR*)  

Returns part numbers that begin with “XTR”  

Description: …VALVE… 
(or *VALVE*) 

Returns parts with the word “VALVE” 
anywhere in the description.  

Category: …A (or *A)  Returns parts with a category ending with the 
letter “A”.  
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